DSI Wireless Interface Module

22-WIM-N1
22-WIM-N4S
FRN 1.xxx

User Manual
Important User Information

Solid state equipment has operational characteristics differing from those of electromechanical equipment. Safety Guidelines for the Application, Installation and Maintenance of Solid State Controls (Publication SGI-1.1 available from your local Rockwell Automation sales office or online at http://www.rockwellautomation.com/literature) describes some important differences between solid state equipment and hard-wired electromechanical devices. Because of this difference, and also because of the wide variety of uses for solid state equipment, all persons responsible for applying this equipment must satisfy themselves that each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc. is prohibited.

Throughout this manual, when necessary we use notes to make you aware of safety considerations.

---

**WARNING:** Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal injury or death, property damage, or economic loss.

**Important:** Identifies information that is critical for successful application and understanding of the product.

**ATTENTION:** Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. Attentions help you, identify a hazard, avoid the hazard, and recognize the consequences.

**Shock Hazard** labels may be located on or inside the equipment (e.g., drive or motor) to alert people that dangerous voltage may be present.

**Burn Hazard** labels may be located on or inside the equipment (e.g., drive or motor) to alert people that surfaces may be at dangerous temperatures.

---

Allen-Bradley, PowerFlex, Pocket DriveExplorer for Pocket PC, DriveExplorer, and DriveExecutive are either registered trademarks or trademarks of Rockwell Automation, Inc.
The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc.
DeviceNet is a trademark of the Open DeviceNet Vendor Association.
ControlNet is a trademark of ControlNet International Ltd.
Windows and Microsoft are registered trademarks of Microsoft Corp.
The information below summarizes the changes made to this manual since its last release (July 2005):

<table>
<thead>
<tr>
<th>Description of Change</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Chapter 3 in the “Using Pocket DriveExplorer for Pocket PC” section, added the</td>
<td>3-8</td>
</tr>
<tr>
<td>new subsection “Assigning a Name for the WIM.”</td>
<td></td>
</tr>
<tr>
<td>In Chapter 3 in the “Using DriveExplorer/DriveExplorer Lite” section, added the</td>
<td>3-14</td>
</tr>
<tr>
<td>new subsection “Assigning a Name for the WIM.”</td>
<td></td>
</tr>
<tr>
<td>In Chapter 3 in the “Using DriveExecutive” section, added the new subsection</td>
<td>3-23</td>
</tr>
<tr>
<td>“Assigning a Name for the WIM.”</td>
<td></td>
</tr>
</tbody>
</table>

The information below summarizes the changes made to this manual since its last release (March 2005):

<table>
<thead>
<tr>
<th>Description of Change</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Chapter 1:</td>
<td></td>
</tr>
<tr>
<td>• In section “Equipment Shipped with the WIM,” added categories and items for</td>
<td>1-3</td>
</tr>
<tr>
<td>22-WIM-N1 and 22-WIM-N4S.</td>
<td></td>
</tr>
<tr>
<td>• In Step 3 of the Quick Start table:</td>
<td>1-5</td>
</tr>
<tr>
<td>– Corrected Comm Flt Action parameter number from “02” to “07.”</td>
<td></td>
</tr>
<tr>
<td>– Corrected Security Mode parameter number from “03” to “05.”</td>
<td></td>
</tr>
<tr>
<td>– Corrected Security PIN parameter number from “04” to “06.”</td>
<td></td>
</tr>
<tr>
<td>– Added “Use the RTU Master mode to …” and a reference to Appendix D.</td>
<td></td>
</tr>
<tr>
<td>In Chapter 3 in subsection “To reset a PIN number when misplaced or</td>
<td>3-26</td>
</tr>
<tr>
<td>forgotten,” added information to retrieve a stored PIN number.</td>
<td></td>
</tr>
</tbody>
</table>
Summary of Changes
**Table of Contents**

**Preface**
- About This Manual
  - Related Documentation ........................................ P-1
  - Rockwell Automation Support ................................ P-2
  - Conventions Used in This Manual .......................... P-3
  - Third-Party Bluetooth Support ................................. P-3

**Chapter 1**
- Getting Started
  - Components .................................................. 1-1
  - Features .................................................... 1-2
  - Compatible Products ....................................... 1-2
  - Required Equipment ....................................... 1-3
  - Safety Precautions ......................................... 1-4
  - Quick Start ................................................. 1-5
  - Status Indicator .......................................... 1-6

**Chapter 2**
- Installing the WIM
  - Installing the NEMA 1 WIM (22-WIM-N1) .................. 2-1
  - Installing the NEMA 4 WIM (22-WIM-N4S) ................ 2-2
  - Removing the NEMA 1 WIM (22-WIM-N1) ................... 2-4

**Chapter 3**
- Configuring the WIM
  - Configuration Tools ....................................... 3-1
  - Using Pocket DriveExplorer for Pocket PC ............... 3-2
  - Using DriveExplorer/DriveExplorer Lite .................. 3-10
  - Using DriveExecutive ..................................... 3-16
  - Setting the Fault Action .................................. 3-24
  - Enabling and Setting the Security Mode .................. 3-25
  - Resetting the WIM ......................................... 3-26

**Chapter 4**
- Troubleshooting
  - Understanding the Status Indicator ..................... 4-1
  - Viewing WIM Diagnostic Items ............................ 4-3
  - Viewing and Clearing Events .............................. 4-4
  - Viewing and Clearing DF1 Communication Statistics .... 4-5

**Appendix A**
- Specifications
  - Communications ............................................. A-1
  - Electrical .................................................. A-1
  - Mechanical ................................................ A-1
  - Environmental ............................................ A-2
  - Regulatory Compliance ................................. A-2
<table>
<thead>
<tr>
<th>Appendix B</th>
<th>WIM Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>About Parameter Numbers ............................................................................... B-1</td>
</tr>
<tr>
<td></td>
<td>Parameter List ............................................................................................ B-1</td>
</tr>
<tr>
<td>Appendix C</td>
<td>Wireless Flash Updating DSI Peripherals</td>
</tr>
<tr>
<td></td>
<td>Using Pocket DriveExplorer for Pocket PC .................................................. C-1</td>
</tr>
<tr>
<td></td>
<td>Using DriveExplorer/DriveExplorer Lite ..................................................... C-6</td>
</tr>
<tr>
<td></td>
<td>Using DriveExecutive ................................................................................... C-11</td>
</tr>
<tr>
<td>Appendix D</td>
<td>Using RTU Master Mode</td>
</tr>
<tr>
<td></td>
<td>Establishing Wireless Connection ................................................................. D-1</td>
</tr>
<tr>
<td></td>
<td>Configuring the Drive Parameters .................................................................. D-2</td>
</tr>
<tr>
<td></td>
<td>Configuring the WIM for RTU Master Mode ..................................................... D-4</td>
</tr>
<tr>
<td></td>
<td>System Wiring .............................................................................................. D-6</td>
</tr>
<tr>
<td></td>
<td>Accessing the Drives on RTU Master Network ................................................ D-8</td>
</tr>
</tbody>
</table>

Glossary

Index
About This Manual

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Documentation</td>
<td>P-1</td>
</tr>
<tr>
<td>Rockwell Automation Support</td>
<td>P-2</td>
</tr>
<tr>
<td>Conventions Used in This Manual</td>
<td>P-3</td>
</tr>
<tr>
<td>Third-Party Bluetooth Support</td>
<td>P-3</td>
</tr>
</tbody>
</table>

Related Documentation

<table>
<thead>
<tr>
<th>For:</th>
<th>Refer to:</th>
<th>Publication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pocket DriveExplorer™ for Pocket PC</td>
<td><a href="http://www.ab.com/drives/driveexplorer">http://www.ab.com/drives/driveexplorer</a>, and Pocket DriveExplorer for Pocket PC online help (installed with the software)</td>
<td>—</td>
</tr>
<tr>
<td>DriveExplorer™</td>
<td><a href="http://www.ab.com/drives/driveexplorer">http://www.ab.com/drives/driveexplorer</a>, and DriveExplorer online help (installed with the software)</td>
<td>—</td>
</tr>
<tr>
<td>DriveTools™ SP (includes DriveExecutive™)</td>
<td><a href="http://www.ab.com/drives/drivetools">http://www.ab.com/drives/drivetools</a>, and DriveExecutive online help (installed with the software)</td>
<td>—</td>
</tr>
<tr>
<td>HIM</td>
<td>HIM Quick Reference</td>
<td>22HIM-QR001…</td>
</tr>
<tr>
<td>PowerFlex® 4 Drive</td>
<td>PowerFlex 4 User Manual</td>
<td>22A-UM001…</td>
</tr>
<tr>
<td></td>
<td>PowerFlex 4 Quick Start</td>
<td>22A-QS001…</td>
</tr>
<tr>
<td>PowerFlex® 40 Drive</td>
<td>PowerFlex 40 User Manual</td>
<td>22B-UM001…</td>
</tr>
<tr>
<td></td>
<td>PowerFlex 40 Quick Start</td>
<td>22B-QS001…</td>
</tr>
<tr>
<td>PowerFlex® 400 Drive</td>
<td>PowerFlex 400 User Manual</td>
<td>22C-UM001…</td>
</tr>
<tr>
<td>RSLinx™ or RSLinx Lite</td>
<td>Getting Results with RSLinx Guide, and online help (installed with the software)</td>
<td>LINX-GR001…</td>
</tr>
</tbody>
</table>

Documentation can be obtained online at http://www.rockwellautomation.com/literature.
Rockwell Automation Support

Rockwell Automation, Inc. offers support services worldwide, with over 75 sales/support offices, over 500 authorized distributors, and over 250 authorized systems integrators located through the United States alone. In addition, Rockwell Automation, Inc. representatives are in every major country in the world.

Local Product Support

Contact your local Rockwell Automation, Inc. representative for:

- Sales and order support
- Product technical training
- Warranty support
- Support service agreements

Technical Product Assistance

If you need to contact Rockwell Automation, Inc. for technical assistance, please review the information in Chapter 4, Troubleshooting, first. If you still have problems, then access the Allen-Bradley Technical Support web site at www.ab.com/support/abdrives.
Conventions Used in This Manual

The following conventions are used throughout this manual:

- Parameter names are shown in the format Parameter xx - [*]. The xx represents the parameter number, and the * represents the parameter name — for example Parameter 01 - [Adapter Cfg].

- Menu commands are shown in bold type face and follow the format Menu > Command. For example, if you read “Select File > Open,” you should click the File menu and then click the Open command.

- The firmware release is displayed as FRN X.xxx. The “FRN” signifies Firmware Release Number. The “X” is the major release number. The “xxx” is the minor update number.

- Pocket DriveExplorer for Pocket PC (version 1.01), My Bluetooth Places software (version 1.4.2), DriveExplorer Lite (version 4.04), and DriveExecutive (version 3.01) were used for the screen pictures in this manual. Different versions of the software may differ in appearance and procedures.

- This manual provides information about the 22-WIM-N* Wireless Interface Module (WIM) and using it with PowerFlex 4-Class drives. The module can be used with other products that support DSI.

Third-Party Bluetooth Support

Since the WIM requires a Pocket PC, laptop PC or desktop PC equipped with Bluetooth wireless technology, you may need to install a third-party, vendor-specific Bluetooth driver. If this driver fails to establish wireless communication with the WIM, refer to its documentation for assistance. Furthermore, troubleshooting help may be available on the vendor web site.
Notes:
Getting Started

The 22-WIM-N* Wireless Interface Module (WIM) provides a wireless communications interface between a Pocket PC, laptop computer or desktop computer equipped with Bluetooth wireless technology and any Allen-Bradley product supporting DSI. The WIM uses the full-duplex DF1 protocol.

---

### Components

**Figure 1.1 Components of the WIM**

<table>
<thead>
<tr>
<th>Item</th>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Status Indicator | LED that indicates WIM operation, when data is being received from the Bluetooth wireless technology enabled Pocket PC or computer, and when data is being sent to the Pocket PC or computer. Refer to [Status Indicator on page 1-6](#) and [Chapter 4, Troubleshooting](#) for more information.
Features

Features of the WIM include the following:

- A status indicator (LED) that reports the operating status of the module.

- Connectivity to products implementing DSI, such as PowerFlex 4-Class drives and peripherals. When used with a product, the WIM will autobaud to the DSI data rate that is used by the product.

- The WIM receives power from the drive. An outside power source is not needed.

- An RTU Master operating mode for use on an RTU Master network to monitor, configure, and control up to 32 PowerFlex 4-Class drives using wireless communication and Allen-Bradley drive software tools.

- The following tools can be used to configure the WIM:
  - Pocket DriveExplorer for Pocket PC (version 1.01 or higher)
  - DriveExplorer (version 4.04 or higher)
  - DriveExecutive (version 3.01 or higher)
  - PowerFlex 4-Class HIM

- The WIM can be used with compatible Allen-Bradley software tools through wireless communication to flash upgrade itself and other DSI peripherals (PowerFlex 4-Class HIMs and communication adapters) to take full advantage of new firmware features as they become available.

Compatible Products

DSI is based on the Modbus RTU serial communication protocol. The WIM can be used with Allen-Bradley Component Class (PowerFlex 4-Class) drives and other products that support DSI. At the time of publication, compatible products include all the following types of:

- PowerFlex 4 drives
- PowerFlex 40 drives
- PowerFlex 40P drives
- PowerFlex 400 drives
Required Equipment

Equipment Shipped with the WIM

When you unpack the WIM, verify that the package includes:

22-WIM-N1
- One Wireless Interface Module
- This manual

22-WIM-N4S
- One Wireless Interface Module
- One 22-HIM-H30 Cable
- This manual

User-Supplied Equipment

To configure the WIM, you must use one of the following:

- Pocket DriveExplorer for Pocket PC software (version 1.01 or higher) running on a Pocket PC equipped with Bluetooth wireless technology
- DriveExplorer software (version 4.04 or higher) running on a laptop or desktop computer equipped with Bluetooth wireless technology
- DriveExecutive stand-alone software (version 3.01 or higher) or bundled with the DriveTools SP suite (version 1.01 or higher) running on a laptop or desktop computer equipped with Bluetooth wireless technology
- PowerFlex 4-Class HIM (22-HIM-*):
Safety Precautions

Please read the following safety precautions carefully.

**ATTENTION:** Risk of injury or death exists from machine motion when using wireless communications and software to Start/Stop/Jog, configure or otherwise communicate with a drive.

Using the control bar feature in Pocket DriveExplorer for Pocket PC, DriveExplorer or DriveExecutive with wireless communications may present safety hazards due to potential loss of the wireless connection. For example, if the wireless connection is interrupted after a start or jog command is initiated from the control bar, the drive cannot be stopped using the control bar until the wireless connection is restored. For this reason, it is required to always use an additional hard-wired stop circuit to disable the drive.

**ATTENTION:** Risk of injury or equipment damage exists. Only personnel familiar with drive and power products and the associated machinery should plan or implement the installation, start-up, configuration, and subsequent maintenance of the product using a WIM. Failure to comply may result in injury and/or equipment damage.

**ATTENTION:** Risk of injury or equipment damage exists. **Parameter 02 - [Comm Flt Action]** lets you determine the action of the WIM and connected drive if DF1 serial communications are disrupted. By default, this parameter faults the drive. You can set this parameter so that the drive continues to run. Precautions should be taken to ensure that the setting of this parameter does not create a risk of injury or equipment damage. When commissioning the drive, verify that your system responds correctly to various situations (for example, a communication disruption or a faulted controller).
Quick Start

This section is designed to help experienced users quickly start using the WIM. If you are unsure how to complete a step, refer to the referenced chapter.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Refer to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Review the safety precautions for the WIM.</td>
<td>Throughout this manual</td>
</tr>
<tr>
<td>2</td>
<td>Install the WIM.</td>
<td>Chapter 2, Installing the WIM</td>
</tr>
<tr>
<td></td>
<td>To install the NEMA 1 WIM (22-WIM-N1) in a remote-mounted HIM bezel (22-HIM-B1), first install the bezel (see HIM Bezel Installation Instructions Publication No. 22HIM-IN002...). Make sure the HIM bezel is connected to the drive port using the 2 m (6.6 ft.) bezel cable. Then place the WIM in the bezel cradle. Apply power to the drive.</td>
<td>Appendix D, Using RTU Master Mode</td>
</tr>
<tr>
<td></td>
<td>For the NEMA 4 WIM (22-WIM-N4S), see Installing the NEMA 4 WIM (22-WIM-N4S) on page 2-2 for installation instructions.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Configure the WIM parameters.</td>
<td>Chapter 3, Configuring the WIM</td>
</tr>
<tr>
<td></td>
<td>The WIM is provided ready for use. It is only necessary to configure the WIM if you want to:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Change the default setting (0 = Fault) for Parameter 07 - [Comm Flt Action]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Enable the WIM security mode using Parameters 05 - [Security Mode] and 06 - [Security PIN]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Use the RTU Master mode to monitor, configure, and control up to 32 PowerFlex 4-Class drives on a network</td>
<td></td>
</tr>
</tbody>
</table>

Figure 1.2  NEMA 1 WIM (22-WIM-N1) Installed in a HIM Bezel (22-HIM-B1)
Status Indicator

The WIM reports its operating status using a tri-color status indicator (Figure 1.3).

Figure 1.3 Status Indications of the WIM

<table>
<thead>
<tr>
<th>Status Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>➊ Solid Blue</td>
<td>The WIM is receiving data from the Bluetooth wireless technology enabled Pocket PC or computer, or transmitting data to the Pocket PC or computer.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>The WIM is operating, but has not established wireless communication with the Bluetooth wireless technology enabled Pocket PC or computer.</td>
</tr>
</tbody>
</table>

If any other conditions occur, refer to Chapter 4, Troubleshooting.
Chapter 2

Installing the WIM

Chapter 2 provides instructions for installing and removing the WIM.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing the NEMA 1 WIM (22-WIM-N1)</td>
<td>2-1</td>
</tr>
<tr>
<td>Installing the NEMA 4 WIM (22-WIM-N4S)</td>
<td>2-2</td>
</tr>
<tr>
<td>Removing the NEMA 1 WIM (22-WIM-N1)</td>
<td>2-4</td>
</tr>
</tbody>
</table>

The WIM is offered in two styles: a NEMA 1 module (22-WIM-N1) and a NEMA 4 module (22-WIM-N4S). Each style is installed differently.

Installing the NEMA 1 WIM (22-WIM-N1)

The NEMA 1 WIM (22-WIM-N1) is installed in a HIM bezel (22-HIM-B1) that is mounted in a remote location.

1. If the HIM bezel is not mounted, refer to the HIM Bezel Installation Instructions Publication No. 22HIM-IN002… for mounting details.

2. Route the bezel cable to the drive. Connect the bezel cable to the DSI port on the bottom of the drive.

3. Install the WIM into the HIM bezel cradle (Figure 2.1).

Figure 2.1 Installing the WIM in a HIM Bezel
4. The status LED on the WIM momentarily flashes red on powerup and then flashes green to indicate it is ready to establish wireless communication with the Pocket PC or computer.

5. Establish wireless communication between the WIM and the Pocket PC or computer. For this procedure, refer to the respective section in Chapter 3 that corresponds to the drive software tool you are using:

   - Using Pocket DriveExplorer for Pocket PC on page 3-2
   - Using DriveExplorer/DriveExplorer Lite on page 3-10
   - Using DriveExecutive on page 3-16

   When communication is achieved, the WIM status LED will turn solid blue.

---

**Installing the NEMA 4 WIM (22-WIM-N4S)**

The NEMA 4 WIM (22-WIM-N4S) is designed for remote installation. Refer to Figure 2.2 for overall WIM dimensions. Choose an appropriate location to mount the NEMA 4 WIM. A cable distance greater than 3 m (10 ft.) is not CE compliant. Maximum cable length should not exceed 10 m (33 ft.).

**Figure 2.2 NEMA 4 WIM Dimensions**

1. Drill the required hole pattern in the panel. See Figure 2.3 for dimensions.
2. Peel the protective film from the gasketed surface on the back of the WIM (Figure 2.4).

3. Insert the supplied 2 m (6.6 ft.) WIM cable into the mating socket on the back of the WIM.

4. Install the supplied O-ring into the cable routing hole on the panel to protect the cable. Then route the WIM cable through the cable routing hole on the panel.

5. Align the six threaded studs of the WIM with the panel clearance holes, and place the WIM against the panel.

6. Tighten the nuts onto the six threaded studs of the WIM extending behind the panel. Recommended torque is 0.68 N-m (6.0 lb.-in.).

7. Route the WIM cable to the drive. Connect the WIM cable to the DSI port on the bottom of the drive.

8. Apply power to the drive. The status LED on the WIM momentarily flashes red on powerup and then flashes green to indicate it is ready to establish wireless communication with the Pocket PC or computer.
9. Establish wireless communication between the WIM and the Pocket PC or computer. For this procedure, refer to the respective section in Chapter 3 that corresponds to the drive software tool you are using:

- Using Pocket DriveExplorer for Pocket PC on page 3-2
- Using DriveExplorer/DriveExplorer Lite on page 3-10
- Using DriveExecutive on page 3-16

When communication is achieved, the WIM status LED will turn solid blue.

Figure 2.4 Mounting NEMA 4 WIM onto Panel

Removing the NEMA 1 WIM (22-WIM-N1)

**ATTENTION:** Risk of injury or equipment damage exists. If the HIM bezel cable (for a bezel-mounted WIM) is disconnected from Port 2 on the bottom of the drive, the drive may fault. Determine how the drive will respond before disconnecting the cable.

The drive can remain powered when removing a WIM.

Remove the WIM from the remote-mounted HIM bezel.
Chapter 3 provides information about configuring the WIM.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Tools</td>
<td>3-1</td>
</tr>
<tr>
<td>Using Pocket DriveExplorer for Pocket PC</td>
<td>3-2</td>
</tr>
<tr>
<td>Using DriveExplorer/DriveExplorer Lite</td>
<td>3-10</td>
</tr>
<tr>
<td>Using DriveExecutive</td>
<td>3-16</td>
</tr>
<tr>
<td>Setting the Fault Action</td>
<td>3-24</td>
</tr>
<tr>
<td>Enabling and Setting the Security Mode</td>
<td>3-25</td>
</tr>
<tr>
<td>Resetting the WIM</td>
<td>3-26</td>
</tr>
</tbody>
</table>

TIP: The WIM is provided ready for use. It is only necessary to configure the WIM if you want to:

- Change the default setting (0 = Fault) for **Parameter 07 - [Comm Flt Action]**.
- Enable the security mode using **Parameters 05 - [Security Mode]** and **06 - [Security PIN]**.
- Use the RTU Master mode to monitor, configure, and control up to 32 PowerFlex 4-Class drives on a network. (See Appendix D for details.)

For a list of parameters, refer to Appendix B, WIM Parameters. For definitions of terms in this chapter, refer to the Glossary.

### Configuration Tools

The WIM stores parameters and other information in its own Non-Volatile Storage (NVS). You must, therefore, access the WIM to view and edit its parameters. The following table lists tools that you can use to access the WIM and edit its parameters.

<table>
<thead>
<tr>
<th>Device Type</th>
<th>Tool</th>
<th>Refer to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pocket PC</td>
<td>Pocket DriveExplorer for Pocket PC (version 1.01 or higher)</td>
<td>Page 3-2</td>
</tr>
<tr>
<td>Laptop or Desktop</td>
<td>DriveExplorer software (version 4.04 or higher)</td>
<td>Page 3-10</td>
</tr>
<tr>
<td>Desktop Computer</td>
<td>DriveExecutive software (version 3.01 or higher)</td>
<td>Page 3-16</td>
</tr>
<tr>
<td></td>
<td>PowerFlex HIM</td>
<td>---</td>
</tr>
</tbody>
</table>
Using Pocket DriveExplorer for Pocket PC

With Pocket DriveExplorer for Pocket PC software running on a Pocket PC equipped with Bluetooth wireless technology, you can edit parameters in the WIM, connected drive, and any of the attached peripherals.

If you are unsure how to use Pocket DriveExplorer for Pocket PC, refer to the online help (select Help > Help Topics).

**ATTENTION:** Risk of injury or death exists from machine motion when using wireless communications and software to Start/Stop/Jog, configure or otherwise communicate with a drive.

Using the control bar feature in Pocket DriveExplorer for Pocket PC (version 2.01 or higher) with wireless communications may present safety hazards due to potential loss of the wireless connection. For example, if the wireless connection is interrupted after a start or jog command is initiated from the control bar, the drive cannot be stopped using the control bar until the wireless connection is restored. For this reason, it is required to always use an additional hard-wired stop circuit to disable the drive.

Establishing Wireless Communication Between the WIM and Pocket PC

1. Launch Pocket DriveExplorer for Pocket PC from the Today Screen to create a new connection using the Connection Manager (Figure 3.1).

**Figure 3.1** Connection Manager Screen
2. Select Connect > New from the menu list. The New Connection Wizard (Figure 3.2) appears.

Figure 3.2 New Connection Wizard Screen

3. Select the “Bluetooth” radio button and tap Next ->. The “Where is your destination?” screen (Figure 3.3) appears.

Figure 3.3 “Where is your destination?” Screen

4. Select one of the radio button choices:
   - **Local - point-to-point**: Choose “Local” if you want to connect only to a local drive using the WIM. Selecting “Local” and tapping Next -> displays the “Local Connection” screen (Figure 3.4) which requests you to name the connection for later reuse.

   - **Remote - routed over a network**: Choose “Remote” if you want to connect to a local drive using the WIM and then route through it to a remote device on DeviceNet™ (via 22- COMM-D adapter), ControlNet™ (via 22-COMM-C adapter) or EtherNet/IP (via
22-COMM-E adapter). Also choose “Remote” when you intend to operate the WIM in RTU Master mode. See Appendix D for details. If you select “Remote,” disregard Steps 5 through 9 and instead, go directly to Step 10 on Page 3-6 and perform sub-steps A through H.

Figure 3.4 Local Connection Screen

5. Enter a name and tap Next ->. The “Connection Summary” screen (Figure 3.5) appears.

Figure 3.5 Connection Summary Screen

6. You can save the connection information and connect immediately, or save the connection for connecting later.

After making a selection, the “Location for saved connection” screen (Figure 3.6) appears, enabling you to navigate to a desired location on the Pocket PC to store connections.
7. Tap **OK** to save the connection file and begin the connection process. The “Searching for Bluetooth Connections” screen (Figure 3.7) appears, asking you to select a detected Bluetooth device.

8. Select the Bluetooth device from this screen and tap **OK**. This screen only appears the first time you connect to this Bluetooth device. Its address is saved to the connection file. The next time you open the connection, if this same device is within range, Pocket DriveExplorer for Pocket PC will immediately connect.

   The connection process then begins (Figure 3.8).
9. The status bar will update and then when connection is complete, the StatusMonitor application will launch and show the “StatusMonitor” screen (Figure 3.9) for the drive.

![DriveStatusMonitor Screen](image)

You can then select other devices from the Port menu, or other functions from the Tasks menu.

10. If you will be routing to one or more remote networked drives, you will need to perform sub-steps A through H in this step. This requires that you are able to connect to the Bluetooth card/module (cannot be done offline) because Pocket DriveExplorer for Pocket PC must interrogate the device and determine what kinds of network adapters are present.

For an example illustrating remote connection, we are using two PowerFlex 40 drives with 22-COMM-D DeviceNet adapters connected to each other using standard DeviceNet cabling.
A. With the “Where is your destination?” screen (Figure 3.10) displayed and “Remote” selected, tap **Next ->** to display the “Searching for Bluetooth Devices:” screen (Figure 3.11) that lists the detected Bluetooth devices.

![Figure 3.10 “Where is your destination?” Screen](image)

![Figure 3.11 Bluetooth Browser Screen](image)

B. Select the Bluetooth device to which you want Pocket DriveExplorer for Pocket PC to connect to, and tap **OK**.

C. With the Remote Configuration screen (Figure 3.12) displayed, enter a name (for this example, Drive 1) for the drive. Then set its node address (for this example, “1”) to match the node address of the 22-COMM-D DeviceNet adapter in Drive 1.

![Figure 3.12 Drive 1 Remote Configuration Screen](image)

D. Tap **Next ->** to display the Connection Summary screen (Figure 3.13) which shows information about this drive being connected to the network. Then tap **Save and Connect Now** to
display the “Location for saved connection” screen (Figure 3.14).

E. Use the default name shown or enter a desired name (for this example, Drive 1). Use the default directory shown or select a different path to which the connection is saved on the Pocket PC. Then tap OK. The StatusMonitor screen for the drive appears.

F. From the Drive 1 StatusMonitor screen, select Connect > New… from the menu list. The New Connection Wizard screen appears. Then select the “Bluetooth” radio button and tap Next ->.

G. Repeat sub-steps A through E for each remaining drive on the network.

H. From the last drive’s StatusMonitor screen, select Connect > and the drive to which you want to connect to (for example, Drive 1.dfc). This establishes connection to that drive and displays its StatusMonitor screen.

Note: Using the “Remote” connection option for the WIM establishes a point-to-point connection. Therefore, you can only connect to one networked drive at a time.

Assigning a Name for the WIM (optional)

The WIM can be assigned a custom name (up to 16 alpha-numeric characters) that represents its associated drive’s application function, such as Pump 1 or Conveyor A. After successfully establishing a custom WIM name, it replaces the default drive name (for example, PowerFlex 40 3P 460V 1.0HP) that appears in the “Searching for Bluetooth Devices” screen and will now be recognized on the network.
1. From the drive StatusMonitor screen (Figure 3.9), tap the Port menu and select the drive port to which the WIM is connected. For this example, Port 1 is selected (Figure 3.15) because the WIM is installed in the drive’s bottom RJ-45 port. The WIM StatusMonitor screen (Figure 3.16) appears.

Figure 3.15 Port Selection Screen

![Port Selection Screen](image)

Figure 3.16 WIM StatusMonitor Screen

![WIM StatusMonitor Screen](image)

2. On the WIM StatusMonitor screen (Figure 3.16), tap the stylus on the white area above the “22-WIM-Nx” catalog number to display the User Text entry screen (Figure 3.17). In the text box, enter the desired name for the WIM (for example, Pump 1 shown in Figure 3.18) and tap OK. The WIM StatusMonitor screen reappears with the entered name.

Figure 3.17 User Text Entry Screen

![User Text Entry Screen](image)

Figure 3.18 Pump 1 Screen

![Pump 1 Screen](image)

3. For the entered name to be recognized on the network, either reset the WIM or power cycle the drive. Then re-establish wireless communication between the WIM and Pocket PC.
Using DriveExplorer/DriveExplorer Lite

With DriveExplorer software running on a computer equipped with Bluetooth wireless technology, you can edit parameters in the WIM, connected drive, and any of the attached peripherals. DriveExplorer Lite, a free, limited-feature version of DriveExplorer, can be downloaded from http://www.ab.com/drives/driveexplorer.

If you are unsure how to use DriveExplorer or DriveExplorer Lite, refer to the online help (select Help > Help Topics).

ATTENTION: Risk of injury or death exists from machine motion when using wireless communications and software to Start/Stop/Jog, configure or otherwise communicate with a drive.

Using the control bar feature in DriveExplorer (version 2.01 or higher) with wireless communications may present safety hazards due to potential loss of the wireless connection. For example, if the wireless connection is interrupted after a start or jog command is initiated from the control bar, the drive cannot be stopped using the control bar until the wireless connection is restored. For this reason, it is required to always use an additional hard-wired stop circuit to disable the drive.

Establishing Wireless Communication Between the WIM and Computer

Bluetooth wireless technology enabled cards/modules installed in a computer are typically provided with a software program to establish communication with other wireless devices. The following example procedure describes how to establish communication using the software program “My Bluetooth Places” (version 1.4.2), which was included with a specific brand Bluetooth wireless technology module. Different versions of this software and different programs may differ in appearance and procedures.

1. Launch the “My Bluetooth Places” program. The program window (Figure 3.19) will appear.
2. In the “My Bluetooth Places” program window, double-click the “Find Bluetooth Devices” icon, which starts a search to find the device to which you want to connect. The “Entire Bluetooth Neighborhood” window (Figure 3.20) appears, displaying icons of all Bluetooth wireless technology enabled devices detected by the computer card or module that are within its reception range.

**Important:** Wait for the search to complete before proceeding.

Figure 3.20 Entire Bluetooth Neighborhood Window
3. In the “Entire Bluetooth Neighborhood” window, double-click on the device icon to which you want to establish wireless communication (for this example, the “PowerFlex 40” icon). The “PowerFlex 40” connection window (Figure 3.21) will appear.

![Figure 3.21 PowerFlex 40 Connection Window](image)

4. In the “PowerFlex 40” connection window, double-click the “COM1 on PowerFlex…” icon to initiate the wireless communication connection. A pop-up dialog box (Figure 3.22) appears, indicating the specific COM port to use for the connection (COM8 for this example). Click OK.

**Important:** Always note the COM port shown in the dialog box because this same specific port must be selected in the DriveExplorer/DriveExplorer Lite Configure Communication window (Step 6).

![Figure 3.22 COM8 Dialog Box](image)
The “PowerFlex 40” connection window (Figure 3.23) re-appears, but this time with the “COM1 on PowerFlex…” icon lit up in green, indicating that a wireless communication connection now exists.

**Figure 3.23  PowerFlex 40 Connection Window with Lit Green Icon**

5. Launch DriveExplorer or DriveExplorer Lite to access parameters in the WIM, connected drive, and any connected peripherals. Then select **Explore > Configure Communication**. The Configure Communication screen (Figure 3.24) will appear.

**Figure 3.24  DriveExplorer/DriveExplorer Lite Configure Communication Screen**

6. Select the same COM port established by the *Bluetooth* wireless technology enabled computer (noted in Step 4). For this example, COM8 is used. There is no need to set the baud rate or change any other settings. Then click **OK**.
7. In the DriveExplorer or DriveExplorer Lite window, select **Explore > Connect > Serial Point-to-Point** to display the DriveExplorer menu tree window. In the left pane, click the + signs to expand the tree. For this example, click on “22-WIM-Nx DF1 Wireless Module” to display the WIM parameters in the right pane (Figure 3.25). Double-click a parameter to edit it.

**Figure 3.25 DriveExplorer/DriveExplorer Lite Menu Tree Window**

Assigning a Name for the WIM (optional)

The WIM can be assigned a custom name (up to 16 alpha-numeric characters) that represents its associated drive’s application function, such as Pump 1 or Conveyor A. After successfully establishing a custom WIM name, it replaces the default drive name (for example, PowerFlex 40 3P 460V 1.0HP) that appears in the “Entire Bluetooth Neighborhood” screen and will now be recognized on the network.

1. With the DriveExplorer/DriveExplorer Lite Menu Tree window (Figure 3.25) displayed and the “22-WIM-Nx DF1 Wireless Module” selected, select **Explore > Device Properties…** to display the WIM’s properties screen (Figure 3.26).

**Figure 3.26 WIM Properties Screen**
2. In the text box, enter the desired name (for example, Pump 1) and click **Apply**. Then click **Close** to close the WIM properties screen.

**TIP:** When using DriveExplorer version 5.01 or higher, you can also name the WIM with this alternate method:

A. With the DriveExplorer/DriveExplorer Lite Menu Tree window (Figure 3.25) displayed, select the “22-WIM-Nx Wireless Module” in the tree view to display the WIM Product Window (Figure 3.27) in the right pane.

![Figure 3.27 WIM Product Window](image)

B. Click the gray “22-WIM-Nx” title header in the WIM Product Window to display the WIM name text entry box (Figure 3.28).

![Figure 3.28 WIM Name Text Entry Box](image)

C. Enter the desired name (for example, Pump 1) and click **Apply**.

3. For the entered name to be recognized on the network, either reset the WIM or power cycle the drive. Then re-establish wireless communication between the WIM and the desktop or laptop computer.
Using DriveExecutive

With DriveExecutive software running on a computer equipped with Bluetooth wireless technology, you can edit parameters in the WIM, connected drive, and any of the attached peripherals.

If you are unsure how to use DriveExecutive, refer to the online help (select Help > Help Topics).

ATTENTION: Risk of injury or death exists from machine motion when using wireless communications and software to Start/Stop/Jog, configure or otherwise communicate with a drive.

Using the control bar feature in DriveExecutive (version 4.01 or higher) with wireless communications may present safety hazards due to potential loss of the wireless connection. For example, if the wireless connection is interrupted after a start or jog command is initiated from the control bar, the drive cannot be stopped using the control bar until the wireless connection is restored. For this reason, it is required to always use an additional hard-wired stop circuit to disable the drive.

Establishing Wireless Communication Between the WIM and Computer

Bluetooth wireless technology enabled cards/modules installed in a computer are typically provided with a software program to establish communication with other wireless devices. The following example procedure describes how to establish communication using the software program “My Bluetooth Places” (version 1.4.2), which was included with a specific brand Bluetooth wireless technology module. Different versions of this software and different programs may differ in appearance and procedures.

1. Launch the “My Bluetooth Places” program. The program window (Figure 3.29) will appear.
2. In the “My Bluetooth Places” program window, double-click the “Find Bluetooth Devices” icon, which starts a search to find the device to which you want to connect. The “Entire Bluetooth Neighborhood” window (Figure 3.30) appears, displaying icons of all Bluetooth wireless technology enabled devices detected by the computer card or module that are within its reception range.

**Important:** Wait for the search to complete before proceeding.
3. In the “Entire Bluetooth Neighborhood” window, double-click on the device icon to which you want to establish wireless communication (for this example, the “PowerFlex 40” icon). The “PowerFlex 40” connection window (Figure 3.31) will appear.

**Figure 3.31  PowerFlex 40 Connection Window**

4. In the “PowerFlex 40” connection window, double-click the “COM1 on PowerFlex…” icon to initiate the wireless communication connection. A pop-up dialog box (Figure 3.32) appears, indicating the specific COM port to use for the connection (COM8 for this example). Click **OK**.

**Important:** Always note the COM port shown in the dialog box because this same specific port must be selected in the RSLinx Configure RS-232 DF1 Devices window (Step 6).

**Figure 3.32  COM8 Dialog Box**
The “PowerFlex 40” connection window (Figure 3.33) re-appears, but this time with the “COM1 on PowerFlex…” icon lit up in green, indicating that a wireless communication connection now exists.

5. Launch RSLinx to create a driver to represent the connection on COM8 (communication port assigned in Step 4 on Page 3-18).

6. Select Communication > Configure Drivers… to display the Configure Drivers screen. From the Available Driver Types pull-down list, select “RS-232 DF1 devices” as shown in (Figure 3.34).

Figure 3.33  PowerFlex 40 Connection Window with Lit Green Icon

Figure 3.34  Configure Drivers Screen
7. After the driver is selected, click the Add New… button. The Add New RSLinx Driver screen will appear. Create a name for the new driver or use the default name, and click OK.

8. The Configure RS-232 DF1 Devices window (Figure 3.35) appears.

![Figure 3.35 Configure RS-232 DF1 Devices Window](image)

Use the following settings:

<table>
<thead>
<tr>
<th>Configuration Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comm Port</td>
<td>Select the same COM port established by the Bluetooth wireless technology enabled computer (noted in Step 4). For this example, COM8 is used.</td>
</tr>
<tr>
<td>Device</td>
<td>1770-KF2/1785-KE/SCANport</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Any setting</td>
</tr>
<tr>
<td>Station Number</td>
<td>00</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Error Checking</td>
<td>Any setting</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Protocol</td>
<td>Full Duplex</td>
</tr>
</tbody>
</table>

Then click OK.

9. The Configure Drivers window (Figure 3.36) will re-appear. Verify that the status of the newly created driver is “Running.” Then click Close.
10. Select **Communications > RSWho** to display the browse window. Then expand the menu tree in the left pane to display either the “Unrecognized Device” icon (which represents the drive) or the “DSI” icon to verify that the driver is communicating with the device. The screen should look similar to Figure 3.37.

Figure 3.37  **RSLinx Browse Window**

11. Launch DriveExecutive to access parameters in the WIM, connected drive, and any connected peripherals.

12. In the DriveExecutive window, select **Drive > Connect to Drive…** to display the Connect to Drive menu tree window. Then expand the menu tree in the left pane to display either the “Unrecognized Device” icon (which represents the drive) or the “DSI” icon. The screen should look similar to Figure 3.38.
13. Then click **OK**. DriveExecutive will begin updating drive information such as parameter names, diagnostics, etc. and store them in a DriveExecutive directory established for this purpose.

14. In the left pane of the DriveExecutive menu tree window, click the + signs to expand the tree. For this example, click on “22-WIM-Nx” and click “Linear List” to display the WIM parameters in the right pane (**Figure 3.39**). To edit a parameter, double-click it or use the Value column pull-down menu.

**Figure 3.39 DriveExecutive Menu Tree Window**
Assigning a Name for the WIM (optional)

The WIM can be assigned a custom name (up to 16 alpha-numeric characters) that represents its associated drive’s application function, such as Pump 1 or Conveyor A. After successfully establishing a custom WIM name, it replaces the default drive name (for example, PowerFlex 40 3P 460V 1.0HP) that appears in the “Entire Bluetooth Neighborhood” screen and will now be recognized on the network.

1. With the DriveExecutive Menu Tree window (Figure 3.39) displayed and the “22-WIM-Nx DF1” selected, select Peripheral > Properties… to display the WIM’s Properties screen (Figure 3.40).

![Figure 3.40  WIM Properties Screen](image)

2. In the text box, enter the desired name (for example, Pump 1) and click OK.

3. For the entered name to be recognized on the network, either reset the WIM or power cycle the drive. Then re-establish wireless communication between the WIM and the desktop or laptop computer.
By default, when communications are disrupted (for example, loss of wireless communication), the WIM and connected drive respond by faulting. You can configure a different response to communication disruptions using **Parameter 07 - [Comm Flt Action]**.

---

**ATTENTION:** Risk of injury or equipment damage exists.

**Parameter 07 - [Comm Flt Action]** lets you determine the action of the WIM and connected drive if communications are disrupted. By default, this parameter faults the drive. You can set this parameter so that the drive continues to run. Precautions should be taken to ensure that the setting of this parameter does not create a risk of injury or equipment damage. When commissioning the drive, verify that your system responds correctly to various situations (for example, disruption of wireless communication).

---

### To change the fault action

Set the value of **Parameter 07 - [Comm Flt Action]** to the desired response:

<table>
<thead>
<tr>
<th>Value</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Fault</td>
<td>The drive will fault.</td>
</tr>
<tr>
<td>1</td>
<td>Stop</td>
<td>The drive will stop and not fault.</td>
</tr>
<tr>
<td>2</td>
<td>Zero data</td>
<td>The drive is sent 0 for output data after a communications disruption. This does not command a stop.</td>
</tr>
<tr>
<td>3</td>
<td>Hold last</td>
<td>The drive continues in its present state after a communications disruption.</td>
</tr>
</tbody>
</table>

Changes to this parameter take effect immediately. A reset is not required.
The WIM has a security mode to prevent access to its configuration settings. You can enable the security mode using **Parameter 05 - [Security Mode]**, and set a desired PIN number using **Parameter 06 - [Security PIN]**.

**To enable the WIM security mode**

1. Set **Parameter 05 - [Security Mode]** to “PIN Required.”

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>PIN Not Required (Default)</td>
</tr>
<tr>
<td>1</td>
<td>PIN Required</td>
</tr>
</tbody>
</table>

2. Reset the WIM (see **Resetting the WIM on page 3-26**).

**To set a PIN number**

1. Set **Parameter 06 - [Security PIN]** to a desired 4-digit number (0000-9999). The default is “0000.”

   For your convenience, please write down your assigned PIN number and store it in a safe place:

   PIN Number = ___ ___ ___ ___

2. Reset the WIM (see **Resetting the WIM on page 3-26**).

**To use the WIM when security mode is enabled**

When establishing a wireless connection to the WIM for the first time, entry of the PIN number will be requested. However, PIN number entry will not be requested for any subsequent connection when using the same device (Pocket PC, desktop computer or laptop computer). If you do not secure your Pocket PC or computer against unauthorized use, the WIM security feature will not provide its intended protection.
To reset a PIN number when misplaced or forgotten

If you misplaced or forget the assigned PIN number, you will not be able to connect to the WIM using drive software. To reset the PIN number, you will need to access the WIM through a different DSI peripheral (for example, 22-HIM). Using that peripheral, select Parameter 05 - [Security Mode] and set it to “0” (PIN Not Required). Then select Parameter 06 - [Security PIN] to view the stored PIN number.

When using the WIM in RTU Master mode, DSI peripherals are not supported. In this case, call Drives Technical Support for assistance. (See Page P-2 for contact information.)

Resetting the WIM

Changes to some WIM parameters require that you reset the WIM before the new settings take effect. You can reset the WIM by cycling power to the drive or by using Parameter 08 - [Reset Module].

Set Parameter 08 - [Reset Module] to Reset Module.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Ready (Default)</td>
</tr>
<tr>
<td>1</td>
<td>Reset Module</td>
</tr>
<tr>
<td>2</td>
<td>Set Defaults</td>
</tr>
</tbody>
</table>

After you enter 1 = Reset Module, the WIM will be immediately reset.

Important: This will break the wireless connection, so you will need to re-establish the connection.

When you enter 2 = Set Defaults, the WIM will set all WIM parameters to their factory-default settings. After performing a Set Defaults, enter 1 = Reset Module so that the new values take effect. The value of this parameter will be restored to 0 = Ready after performing the reset or setting the defaults.
Chapter 4 provides information to troubleshoot the WIM.

### Understanding the Status Indicator

The WIM reports its operating status using a status indicator (Figure 4.1).

**Figure 4.1  Status Indications of the WIM**

![Status Indicator Image]

(NEMA 1 WIM shown)

### Status Indications

<table>
<thead>
<tr>
<th>Status</th>
<th>Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>WIM is not powered.</td>
<td>• Securely place WIM in bezel, or securely connect bezel or WIM cable to the drive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Apply power to the drive.</td>
</tr>
<tr>
<td>Status</td>
<td>Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Flashing Green              | WIM is communicating with drive, but not transmitting or receiving wireless signals. | This is normal behavior for a WIM when it is operational, but not communicating with a wireless device. Establish wireless communication with the Bluetooth wireless technology enabled Pocket PC or computer. For this procedure, refer to the respective section in Chapter 3 that corresponds to the drive software tool you are using:  
  - Using Pocket DriveExplorer for Pocket PC on page 3-2  
  - Using DriveExplorer/DriveExplorer Lite on page 3-10  
  - Using DriveExecutive on page 3-16 |
| Flashing Green/Red          | WIM is in boot mode, or WIM may have a corrupted flash file.         | Reflash WIM firmware. If issue persists, return WIM to factory for repair/replacement. |
| Solid Blue                  | WIM is communicating with drive, or is in process of flash updating (WIM or DSI peripheral). | No action required.                                                                |
| Solid Red                   | Internal communication error. WIM diagnostic and initialization sequence did not complete. | Power cycle the drive. Check cables and their connections. If issue persists, return WIM to factory for repair/replacement. |
| Flashing Red                | WIM is not communicating with drive.                                 | Power cycle the drive. Check cables and their connections. If issue persists, return WIM to factory for repair/replacement. |
|                             | WIM is a slave device and the DSI master stopped communicating or was removed. | Power cycle the drive. Check cables and their connections. Check and/or replace 22-COMM-* adapter installed in drive. If issue persists, return WIM to factory for repair/replacement. |
Viewing WIM Diagnostic Items

WIM Diagnostic Items can be viewed with the following tools:

- For Pocket PCs, use Pocket DriveExplorer for Pocket PC software (version 1.01 or higher).
- For laptop or desktop computers, use DriveExplorer software (version 4.04 or higher), DriveExecutive software (version 3.01 or higher)
- An LCD PowerFlex 4-Class HIM.

If you encounter unexpected communications problems, diagnostic items can help you or Rockwell Automation personnel troubleshoot the problem.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Field Flash Cnt</td>
<td>The number of times the WIM has been field flashed.</td>
</tr>
<tr>
<td>2</td>
<td>Adapter Events</td>
<td>The number of events in the event queue.</td>
</tr>
<tr>
<td>3</td>
<td>Reference</td>
<td>The present value of the Reference being transmitted to the drive by the WIM.</td>
</tr>
<tr>
<td>4</td>
<td>Logic Command</td>
<td>The present value of the Logic Command being transmitted to the drive by the WIM.</td>
</tr>
<tr>
<td>5</td>
<td>Logic Status</td>
<td>The present value of the Logic Status being received from the drive by the WIM.</td>
</tr>
<tr>
<td>6</td>
<td>Feedback</td>
<td>The present value of the Feedback being received from the drive by the WIM.</td>
</tr>
<tr>
<td>7</td>
<td>Clear DSI Counts</td>
<td>Clears all DSI counters to zero.</td>
</tr>
<tr>
<td>8</td>
<td>DSI Packets Sent</td>
<td>The number of DSI packets sent by the WIM that are in the correct format.</td>
</tr>
<tr>
<td>9</td>
<td>DSI Packets Rcvd</td>
<td>The number of DSI packets received by the WIM that are in the correct format.</td>
</tr>
<tr>
<td>10</td>
<td>DSI Bad Packets</td>
<td>The number of DSI packets detected by the WIM that have CRC errors.</td>
</tr>
<tr>
<td>11</td>
<td>DSI Retries</td>
<td>The number of DSI messages re-sent because no response was received.</td>
</tr>
</tbody>
</table>

(1) The number of DSI packets may differ due to other DSI peripherals connected to the drive.
Viewing and Clearing Events

The WIM maintains an event queue that reports the history of its actions. You can view the event queue with the following tools:

- For Pocket PCs, use Pocket DriveExplorer for Pocket PC software (version 1.01 or higher).
- For laptop or desktop computers, use DriveExplorer software (version 4.04 or higher), DriveExecutive software (version 3.01 or higher)
- An LCD PowerFlex 4-Class HIM.

To view the event queue

1. Access the event queue using a configuration tool.
2. Scroll through events in the event queue.

Events

Many events in the Event queue occur under normal operation. If you encounter unexpected communications problems, the events may help you or Allen-Bradley personnel troubleshoot the problem. The following events may appear in the event queue:

<table>
<thead>
<tr>
<th>Code</th>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F0</td>
<td>No Event</td>
<td>No event present in the WIM event queue.</td>
</tr>
<tr>
<td>F1</td>
<td>Adapter Reset</td>
<td>The WIM was reset by the user.</td>
</tr>
<tr>
<td>F2</td>
<td>Slave Detected</td>
<td>A slave was detected to be present by the master.</td>
</tr>
<tr>
<td>F3</td>
<td>Slave Removed</td>
<td>A slave was detected to be removed by the master.</td>
</tr>
<tr>
<td>F4</td>
<td>Host Timeout</td>
<td>A timeout condition occurred on Msg to Host.</td>
</tr>
<tr>
<td>F5</td>
<td>Slave Timeout</td>
<td>A timeout condition occurred on Msg to Slave.</td>
</tr>
<tr>
<td>F6</td>
<td>Master Timeout</td>
<td>A timeout condition occurred on Msg to Master.</td>
</tr>
<tr>
<td>F7</td>
<td>Serial Timeout</td>
<td>A timeout occurred on the Serial 232 side (with control enabled).</td>
</tr>
<tr>
<td>F8</td>
<td>Control Enabled</td>
<td>The WIM has sent a “Soft Control Enable” command to the drive.</td>
</tr>
<tr>
<td>F9</td>
<td>Control Disabled</td>
<td>The WIM has sent a “Soft Control Disable” command to the drive.</td>
</tr>
<tr>
<td>F10</td>
<td>EEPROM Sum Flt</td>
<td>The startup sequence detected corrupt EEPROM storage in the WIM.</td>
</tr>
</tbody>
</table>
To clear the event queue

1. Access the event queue using a configuration tool.

2. Set the value of 1 > Clr Event Queue to Enable, and then press Enter to clear the event queue.

Viewing and Clearing DF1 Communication Statistics

If you encounter unexpected communications problems or are creating an application that uses DF1 data, you can view the communications statistics in the WIM. Parameter 10 - [DF1 Packets Sent] and Parameter 11 - [DF1 Packets Rcvd] store this data.

To view and clear DF1 data, you must access the main menu in the WIM firmware.

To view DF1 data

1. Access the parameters in the WIM using a configuration tool.

2. Scroll through the DF1 Parameters 10 and 11, which contain DF1 data. For a description of each parameter, refer to Appendix B, WIM Parameters.

To clear DF1 data

1. Access the parameters in the WIM using a configuration tool.

2. Set the value of Parameter 09 - [Clear DF1 Counts] to “1 = Clear Counts,” and then press Enter to clear the DF1 data.
# Specifications

Appendix A provides the specifications for the WIM.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications</td>
<td>A-1</td>
</tr>
<tr>
<td>Electrical</td>
<td>A-1</td>
</tr>
<tr>
<td>Mechanical</td>
<td>A-1</td>
</tr>
<tr>
<td>Environmental</td>
<td>A-2</td>
</tr>
<tr>
<td>Regulatory Compliance</td>
<td>A-2</td>
</tr>
</tbody>
</table>

## Communications

<table>
<thead>
<tr>
<th>Radio Transceiver</th>
<th>National Semiconductor LMX9820A Bluetooth Serial Port Module, V1.1 Bluetooth Compliant Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>2.402 to 2.480 GHz Frequency Hopping</td>
</tr>
<tr>
<td>Power</td>
<td>2.5mW Maximum RF Output</td>
</tr>
<tr>
<td>Range</td>
<td>Class II – 10 m (32.8 ft.) anticipated* range</td>
</tr>
<tr>
<td></td>
<td>(*will vary due to environmental conditions)</td>
</tr>
</tbody>
</table>

| Drive Protocol             | Drive Serial Interface (DSI)                                                                       |
| Data Rate                  | 19.2 kbps                                                                                         |

## Electrical

| Consumption                | 170mA at +5V DC                                     |
|                           | The WIM draws the required power from the connected product. An external power source is not required. |

## Mechanical

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>NEMA 1 WIM (22-WIM-N1)</th>
<th>NEMA 4 WIM (22-WIM-N4S)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>116.0 mm (4.57 in.)</td>
<td>180.0 mm (7.08 in.)</td>
</tr>
<tr>
<td>Width</td>
<td>70.0 mm (2.75 in.)</td>
<td>93.0 mm (3.66 in.)</td>
</tr>
<tr>
<td>Depth</td>
<td>16.0 mm (0.63 in.)</td>
<td>25.0 mm (0.98 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>85g (3.0 oz.)</td>
<td>161g (5.7 oz.)</td>
</tr>
</tbody>
</table>
Environmental

<table>
<thead>
<tr>
<th>Temperature</th>
<th>0 to 50°C (32 to 122°F)</th>
<th>-40 to 85°C (-40 to 185°F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative Humidity</td>
<td>5 to 95% non-condensing</td>
<td></td>
</tr>
<tr>
<td>Atmosphere</td>
<td>Important: The WIM must not be installed in an area where the ambient atmosphere contains volatile or corrosive gas, vapors or dust. If the WIM is not going to be installed for a period of time, it must be stored in an area where it will not be exposed to a corrosive atmosphere.</td>
<td></td>
</tr>
<tr>
<td>Vibration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>2.5G @5Hz-2KHz</td>
<td></td>
</tr>
<tr>
<td>Non-Operating</td>
<td>5G @5Hz-2KHz</td>
<td></td>
</tr>
<tr>
<td>Shock</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>30 G peak acceleration, 11 (±1) ms pulse width</td>
<td></td>
</tr>
<tr>
<td>Non-Operating</td>
<td>50 G peak acceleration, 11 (±1) ms pulse width</td>
<td></td>
</tr>
</tbody>
</table>

Regulatory Compliance

<table>
<thead>
<tr>
<th>UL</th>
<th>UL508C</th>
</tr>
</thead>
<tbody>
<tr>
<td>cUL</td>
<td>CAN / CSA C22.2 No. 14-M91</td>
</tr>
<tr>
<td>CE</td>
<td>EN50178 and EN61800-3</td>
</tr>
<tr>
<td>CTick</td>
<td>AS / NZS 2064, Group 1, Class A</td>
</tr>
<tr>
<td>FCC ID</td>
<td>SNT-2XWIMNX</td>
</tr>
<tr>
<td>IC</td>
<td>5450A-2XWIMNX</td>
</tr>
</tbody>
</table>

**NOTE**: This is a product of category C2 according to IEC 61800-3. In a domestic environment this product may cause radio interference in which case supplementary mitigation measures may be required.

FCC Statement of Conditions

**Compliance Statement (Part 15.19)**

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.
Warning (Part 15.21)

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate this equipment.

RF Exposure (OET Bulletin 65)

To comply with FCC RF exposure requirements for mobile transmitting devices, this transmitter should only be used or installed at locations where there is at least 20 cm (7.9 inches) separation distance between the antenna and all persons.

Industry Canada Statement

The term “IC” before the certification/registration number only signifies that the Industry Canada technical specifications were met.
Appendix B presents information about the WIM parameters.

### About Parameter Numbers

The parameters in the WIM are numbered consecutively. You can use the following configuration tools to access the parameters in the WIM.

<table>
<thead>
<tr>
<th>Configuration Tool</th>
<th>Numbering Scheme</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pocket DriveExplorer for Pocket PC</td>
<td>The adapter parameters begin with parameter 01. For example, Parameter 01 - [Adapter Cfg] is parameter 01 as indicated by this manual.</td>
</tr>
<tr>
<td>DriveExplorer</td>
<td></td>
</tr>
<tr>
<td>DriveExecutive</td>
<td></td>
</tr>
<tr>
<td>HIM</td>
<td></td>
</tr>
</tbody>
</table>

### Parameter List

<table>
<thead>
<tr>
<th>No.</th>
<th>Name and Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>[Adapter Cfg]</td>
<td>Default: 0 = Auto&lt;br&gt;Values: 0 = Auto&lt;br&gt;1 = Master&lt;br&gt;2 = Slave&lt;br&gt;3 = RTU Master&lt;br&gt;Type: Read/Write&lt;br&gt;Reset Required: Yes</td>
</tr>
<tr>
<td>02</td>
<td>[Adapter Type]</td>
<td>Default: 0 = Master&lt;br&gt;Value: 0 = Master&lt;br&gt;1 = Slave&lt;br&gt;2 = RTU Master&lt;br&gt;Type: Read Only</td>
</tr>
<tr>
<td>03</td>
<td>[Drive Addr Cfg]</td>
<td>Default: 1&lt;br&gt;Minimum: 1&lt;br&gt;Maximum: 247&lt;br&gt;Type: Read/Write&lt;br&gt;Reset Required: Yes</td>
</tr>
<tr>
<td>No.</td>
<td>Name and Description</td>
<td>Details</td>
</tr>
<tr>
<td>-----</td>
<td>----------------------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| 04  | Drive Addr Act | Displays the node address of the drive that the WIM is communicating with when the WIM is set to RTU Master mode using Parameter 01 - [AdapterCfg].  
Default: 1  
Minimum: 1  
Maximum: 247  
Type: Read Only |
| 05  | Security Mode | Enables/disables the security mode for the WIM, which prevents accessing its parameters and the connected drive for configuration.  
Default: 0  
Values: 0 = PIN Not Req’d  
1 = PIN Required  
Type: Read/Write  
Reset Required: Yes |
| 06  | Security PIN | Sets the PIN number to access WIM parameters for configuration when Parameter 05 - [Security Mode] is set to 1 = PIN Required. See Page 3-25 for details.  
Default: 0  
Minimum: 0  
Maximum: 9999  
Type: Read/Write  
Reset Required: Yes |
| 07  | Comm Flt Action | Sets the action that the WIM and drive will take if the WIM detects that DF1 serial communications are disrupted. This setting is effective only if control I/O is transmitted through the WIM.  
Default: 0 = Fault  
Values: 0 = Fault  
1 = Stop  
2 = Zero Data  
3 = Hold Last  
Type: Read/Write  
Reset Required: No |
| 08  | Reset Module | No action if set to “Ready.” Resets the WIM if set to “Reset Module.” Restores the WIM to its factory default settings if set to “Set Defaults.” This parameter is a command. It will be set to “0 = Ready” after the command has been performed.  
Default: 0 = Ready  
Values: 0 = Ready  
1 = Reset Module  
2 = Set Defaults  
Type: Read/Write  
Reset Required: No |
| 09  | Clear DF1 Counts | No action if set to “Ready.” Resets the DF1 statistical parameters 10 and 11 to 0 if set to “1 = Clear Counts.” This parameter is a command. It will be reset to “0 = Ready” after a “Clear Counts” command has been performed.  
Default: 0 = Ready  
Values: 0 = Ready  
1 = Clear Counts  
Type: Read/Write  
Reset Required: No |
| 10  | DF1 Packets Sent | Displays the number of DF1 packets sent by the WIM. The value of this parameter is normally approximately equal to the Parameter 11 - [DF1 Packets Rcvd] value.  
Default: 0  
Minimum: 0  
Maximum: 65535  
Type: Read Only |
| 11  | DF1 Packets Rcvd | Displays the number of DF1 packets received by the WIM. The value of this parameter is normally approximately equal to the Parameter 10 - [DF1 Packets Sent] value.  
Default: 0  
Minimum: 0  
Maximum: 65535  
Type: Read Only |

**ATTENTION:** Risk of injury or equipment damage exists. Parameter 07 - [Comm Flt Action] lets you determine the action of the WIM and connected drive if communications are disrupted. By default, this parameter faults the drive. You can set this parameter so that the drive continues to run. Precautions should be taken to ensure that the setting of this parameter does not create a risk of injury or equipment damage. When commissioning the drive, verify that your system responds correctly to various situations (for example, a disconnect cable).

**ATTENTION:** Risk of injury or equipment damage exists. The drive will fault when you remove or reset the WIM. Determine how the drive will respond before removing or resetting the WIM.
Appendix C provides information about using the WIM with compatible Allen-Bradley software tools through wireless communication to flash update itself and other DSI peripherals, such as PowerFlex 4-Class HIMs and communication adapters, to take full advantage of new firmware features as they become available.

**Note:** You cannot flash update a PowerFlex 4-Class drive using the WIM. Instead, you must use the AK-U9-FLSH1 PowerFlex 4-Class Flash Update Kit, which includes the flash module with cable, a 1203-SFC cable, and instructions.

**Important:** Using a hard-wired cable connection is the preferred method to flash update a DSI peripheral. However, if the application circumstances dictate that a flash update using wireless communication is necessary, then follow the procedure for the respective software tool in this appendix.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Pocket DriveExplorer for Pocket PC</td>
<td>C-1</td>
</tr>
<tr>
<td>Using DriveExplorer/DriveExplorer Lite</td>
<td>C-6</td>
</tr>
<tr>
<td>Using DriveExecutive</td>
<td>C-11</td>
</tr>
</tbody>
</table>

**Using Pocket DriveExplorer for Pocket PC**

This wireless flash update procedure uses a 22-COMM-D communication adapter as the example DSI peripheral being flashed. When flashing other DSI peripherals, screens associated with that device will be different than those shown in this procedure.

1. Visit the following Allen-Bradley web site to obtain the appropriate firmware update for the DSI peripheral:

   [http://www.ab.com/support/abdrives/webupdate/](http://www.ab.com/support/abdrives/webupdate/)

   At this web site, click on the device to access all of its firmware updates. Then select **Firmware Updates > Application Firmware Updates** (or **vx.xxx Flash Kit**) > **vx.xxx Flash Kit**.
2. Click on the appropriate flash kit version to open the File Download screen (Figure C.1).

Figure C.1 File Download Screen

Important: The Pocket PC must be docked with the desktop or laptop computer during the synchronization process.

Click Open to launch the firmware installation tool. Then click Next > to launch the ControlFLASH wizard to install the device’s firmware update on the desktop or laptop computer. Follow the instructions on the ControlFLASH wizard screens.

Important: In the last screen, the ControlFLASH Setup Complete screen (Figure C.2), uncheck both boxes and click Finish.

Figure C.2 ControlFLASH Setup Complete Screen
3. With the PDE Flash File Xfer (Transfer) Utility installed on your desktop or laptop PC, launch this program (Figure C.3).

Figure C.3  Flash File Transfer Utility Screen

4. In the Select Available Product window (Figure C.4), select the product to list available updates on the desktop or laptop PC (for this example, 20-COMM-D via 22-SCM-232 or 22-WIM). In the Select Available Update window, select the firmware version to be transferred to the Pocket PC for flash updating (for this example, 1.007.01 Full).

Figure C.4  Flash File Firmware Version Screen

Then click **Transfer**. Click **OK** after the files were successfully transferred. Then click **Exit** to close the utility program.
5. Establish wireless communication between the WIM and Pocket PC. For this procedure, refer to Using Pocket DriveExplorer for Pocket PC on page 3-2.

6. With the StatusMonitor screen (Figure C.5) for the drive displayed, select **Port** and then the appropriate port number (for this example, Port 1) to display the StatusMonitor screen (Figure C.6) for the peripheral device being flashed (for this example, the 22-COMM-D).

7. Select **Tasks > Flash Update** to open the DeviceFlash screen (Figure C.7). In the Available Updates list, select the appropriate firmware version (for this example, 1.007.01 Full). Then tap **Next ->** to continue. The DeviceFlash update warning screen (Figure C.8) appears.
8. Tap **Flash** to start the flash update (Figure C.9). When the flash update is complete, Pocket DriveExplorer for Pocket PC will reset the DSI peripheral (Figure C.10).

**Figure C.9** Flash Update Progress Screen

**Figure C.10** Device Reset Screen

*Note:* The WIM status indicator changes from solid blue to flashing red, and then to flashing green after the reset process is complete.

9. Tap **Close** to exit the flash update process (Figure C.11).

**Figure C.11** DeviceFlash Completed Screen

The WIM status indicator changes from flashing green to solid blue, and the StatusMonitor screen will reappear. Verify that the Product Revision number matches the firmware version that was flashed to the peripheral device.
This wireless flash update procedure uses a 22-COMM-D communication adapter as the example DSI peripheral being flashed. When flashing other DSI peripherals, screens associated with that device will be different than those shown in this procedure.

1. Visit the following Allen-Bradley web site to obtain the appropriate firmware update for the device:

   http://www.ab.com/support/abdrives/webupdate/

   At this web site, click on the device to access all of its firmware updates. Then select Firmware Updates > Application Firmware Updates (or vx.xxx Flash Kit) > vx.xxx Flash Kit.

2. Click on the appropriate flash kit version to open the File Download screen (Figure C.12).

   **Figure C.12 File Download Screen**

   ![File Download Screen]

   Click Open to launch the firmware installation tool. Then click Next > to launch the ControlFLASH wizard to install the device’s firmware update on the desktop or laptop computer. Follow the instructions on the ControlFLASH wizard screens.

   **Important:** In the last screen, the ControlFLASH Setup Complete screen (Figure C.13), uncheck both boxes and click Finish.
3. Establish wireless communication between the WIM and the desktop or laptop computer. For this procedure, refer to Using DriveExplorer/DriveExplorer Lite on page 3-10.

4. With the DriveExplorer linear list screen (Figure C.14) displayed, click on the device to be flash updated (for this example, a 22-COMM-D communication adapter).

5. Select Explore > Device Properties... to display the device’s information screen. Then click the Details tab to show a screen (Figure C.15) with the device’s firmware revision information.
6. In the Details tab screen, click the Flash Update… button to open the Select Flash Update screen (Figure C.16).

In the Available Flash Updates window on this screen, select the desired firmware version from the list (for this example, 1.007.01 Full). Then click Next > to continue. The Confirm Flash Update warning screen (Figure C.17) appears.
7. Click **FLASH** to start the flash update (Figure C.18).

**Figure C.18  Executing Flash Update Progress Screen**

**Note:** Near the end of the flash update process, the WIM status indicator changes from solid blue to flashing red, and then to flashing green.

8. When the flash update is completed, the message window in the Executing Flash Update screen changes to indicate that flash update was completed (Figure C.19).
Click **Close** to exit the Flash Update Completed screen. The Device Firmware Changed dialog box (**Figure C.20**) will appear.

**Figure C.20  Device Firmware Changed Dialog Box**

9. Depending on the device being flash updated, do one of the following:

   - **When flashing a peripheral (not the WIM), click Yes.** DriveExplorer will re-establish the wireless connection to the device. Then power cycle the drive to initialize the device with the WIM.

   - **When flashing the WIM, click No.** The wireless connection to the WIM breaks after the flash update, requiring a manual reconnection. Use the **Bluetooth Manager** to re-establish the wireless connection to the WIM. After wireless communication is re-established, DriveExplorer will automatically reconnect to the WIM.

10. With the DriveExplorer linear list screen (**Figure C.14**) displayed, select the device (for this example, a 22-COMM-D communication adapter). Then select **Explore > Device Properties…** to verify that the Revision number shown on the General tab screen matches the firmware version flashed into the device.
Using DriveExecutive

This wireless flash update procedure uses a 22-COMM-D communication adapter as the example device being flashed. When flashing other DSI peripherals, screens associated with that device will be different than those shown in this procedure.

1. Visit the following Allen-Bradley web site to obtain the appropriate firmware update for the device:

   http://www.ab.com/support/abdrives/webupdate/

   At this web site, click on the device to access all of its firmware updates. Then select Firmware Updates > Application Firmware Update (or vx.xxx Flash Kit) > vx.xxx Flash Kit.

2. Click on the appropriate flash kit version to open the File Download screen (Figure C.21).

   ![File Download Screen](image)

   Click Open to launch the firmware installation tool. Then click Next > to launch the ControlFLASH wizard to install the device’s firmware update on the desktop or laptop computer. Follow the instructions on the ControlFLASH wizard screens.

   **Important:** In the last screen, the ControlFLASH Setup Complete screen (Figure C.22), uncheck both boxes and click Finish.
3. Establish wireless communication between the WIM and the desktop or laptop computer. For this procedure, refer to Using DriveExecutive on page C-11.

4. With the DriveExecutive linear list screen (Figure C.23) displayed, right-click on the device to be flash updated (for this example, a 22-COMM-D communication adapter).

5. Select Properties… to display the device’s general information screen. Then click the Component Details tab to show its related screen (Figure C.24).
6. In the Component Details tab screen, click the **Flash Update** button to open the Select Device to Update screen (Figure C.25), which shows the device’s firmware revision information.

![Figure C.24 Component Details Tab Screen](image1)

![Figure C.25 Select Device to Update Screen](image2)

Click on the device to be flashed (for this example, a 22-COMM-D communication adapter), and then click **Next >** to continue. The Select Flash Update screen (Figure C.26) appears.
Wireless Flash Updating DSI Peripherals

Figure C.26  Select Flash Update Screen

7. Select the desired firmware version from the Available Flash Updates list (for this example, 1.007.01 Full). Then click Next > to continue. The Confirm Flash Update warning screen (Figure C.27) appears.

Figure C.27  Confirm Flash Update Warning Screen

8. Click FLASH to start the flash update. The Executing Flash Update screen (Figure C.28) appears.
Note: Near the end of the flash update process, the WIM status indicator changes from solid blue to flashing red, and then to flashing green.

9. When the flash update is completed, the message window in the Executing Flash Update screen changes to indicate that flash update was completed (Figure C.29).

Click Close to exit the Flash Update Completed screen. The Select Device to Update screen (Figure C.25) reappears along with the Windows in-process icon (typically, the hourglass icon). When flashing a peripheral, wait for this icon to disappear (approximately 30 seconds). When flashing the WIM, the icon remains displayed until after the wireless connection is re-established (Step 11).
10. Power cycle the drive to initialize the device with the WIM.

11. Use the Bluetooth Manager to re-establish the wireless connection to the device.

12. On the Select Device to Update screen, verify that the Revision number shown now matches the firmware version flashed into the device.

13. Click Cancel to close the Select Device to Update screen. Then click Cancel again to close the device’s general information screen. The DriveExecutive online window is now ready for use.
Appendix D provides information about using the WIM in RTU Master mode.

With the WIM in RTU Master mode, you can monitor, configure, and control up to 32 PowerFlex 4-Class drives using Allen-Bradley drive software tools.

**TIP:** A total of 247 drives can be supported on the RTU Master network when RS-485 repeaters are installed.

**Important:** All PowerFlex 40 and PowerFlex 400 drives on an RTU Master network must have an open internal Port 1. Thus, a 22-COMM-* adapter cannot be connected to this port via the Internal Interface ribbon cable.

When a drive faults in an RTU Master network, all other drives remain operational and unaffected.

### Establishing Wireless Connection

Establish wireless communication between the WIM and the computer. For this procedure, refer to the respective section in Chapter 3 that corresponds to the drive software tool you are using:

- Using Pocket DriveExplorer for Pocket PC on page 3-2
- Using DriveExplorer/DriveExplorer Lite on page 3-10
- Using DriveExecutive on page 3-16

**Important:** When using DriveExplorer to connect to drives on an RTU Master network, use only DriveExplorer Full since DriveExplorer Lite does not support multi-drive connectivity.
Configuring the Drive Parameters

When setting drive parameters for the following functions to enable operation on an RTU Master network, use each drive’s integral HIM or use the WIM. When using the WIM, electrically connect the WIM to the drive, establish wireless connection with the drive, and use a drive software tool to set its parameters. Then electrically connect the WIM to the next drive and repeat the process until the parameters in all of the drives have been set.

Setting Comm Data Rates

For each drive to be networked (including Drive 1 connected to the WIM), set drive parameter 103 - [Comm Data Rate] to “4” (19.2K).

Setting Drive Addresses

1. For Drive 1 connected to the WIM, set drive parameter 104 - [Comm Node Addr] to match the WIM node address (default = 1) set with Parameter 3 - [Drive Addr Cfg].

   **Important:** When setting a WIM node address, do not use a value higher than “77” octal (or 63 decimal when using DriveExecutive).

2. For each remaining drive to be networked, set drive parameter 104 - [Comm Node Addr] to a unique address.

Setting Comm Loss Action

For each drive to be networked (including Drive 1 connected to the WIM), set drive parameter 105 - [Comm Loss Action] to either “1” (Coast to Stop) or “2” (Stop).

Power Cycle All Drives

Power cycle each drive so that all new settings established in this section will take effect.
For your convenience, use the listing below to note the settings for each drive to be networked.

<table>
<thead>
<tr>
<th>Network Drive Number</th>
<th>Address Setting for Parameter 104 - [Drive Addr Cfg]</th>
<th>Comm Fault Setting for Parameter 105 - [Comm Loss Action]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Configuring the WIM for RTU Master Mode

Using Pocket DriveExplorer for Pocket PC

1. On the drive StatusMonitor screen (Figure D.1), select Port > Port 1 to display the WIM StatusMonitor screen (Figure D.2).

2. Select Tasks > Parameter (Linear) to display the WIM parameter list screen (Figure D.3). Then tap WIM Parameter 01 - [Adapter Cfg] to display the Adapter Cfg parameter screen (Figure D.4).

3. Select RTU Master from the pull-down menu, and tap Apply to confirm the change. Then tap OK (at top right of screen) to return to the WIM parameter list screen.
4. Remove power from the drive to which the wireless connection has been made. Then electrically connect all drives to create the RTU Master network. Refer to System Wiring on page D-6 for network wiring details.

Using DriveExplorer

1. On the DriveExplorer WIM Linear List screen (Figure D.5), double-click WIM Parameter 01 - [Adapter Cfg] and set its value to “3 = RTU Master.”

2. Remove power from the drive to which the wireless connection has been made. Then electrically connect all drives to create the RTU Master network. Refer to System Wiring on page D-6 for network wiring details.

Using DriveExecutive

1. In the Value column of the DriveExecutive WIM Linear List screen (Figure D.6), click on the WIM Parameter 01 - [Adapter Cfg] pull-down list and set its value to “3 = RTU Master.”
2. Remove power from the drive to which the wireless connection has been made. Then electrically connect all drives to create the RTU Master network. Refer to System Wiring on page D-6 for network wiring details.

**System Wiring**

When wiring an RTU Master network, refer to Figure D.7. Connect the first PowerFlex 4-Class drive (Drive 1) on the network to the WIM using an AK-U0-RJ45-SC1 splitter cable. Connect its male end into Port 2 on the bottom of the drive. The WIM must be connected to the Master port (identified by the letter “M” at the port) of the splitter cable.

**Important:** Only one splitter cable can be used on the network, and it must be used to connect the WIM to the first drive.

Using a 22-RJ45CBL-Cxx Communications Cable, or an appropriate twisted pair cable and an AK-U0-RJ45-TB2P terminal block connector (Figure D.8), insert the connector into the splitter cable Slave port (identified by the letter “S” at the port). Then insert the connector on the cable’s other end into Port 2 on the bottom of the second drive (Drive 2).

For all subsequent PowerFlex 4-Class drives (up to 32 drives total on the RTU Master network), daisy-chain them together using the same type of cable and terminal block adapters connected into Port 2 on the bottom of each respective drive.
Using RTU Master Mode

The AK-U0-RJ45-TB2P two-position terminal block connector (Figure D.8) can be used to conveniently daisy-chain the PowerFlex 4-Class drives from Drive 1, which is connected to the WIM. Two terminating resistors are also included with terminal block connectors in the AK-U0-RJ45-TB2P kit.

Figure D.7 Wiring Example for RTU Master Network

Figure D.8 AK-U0-RJ45-TB2P Terminal Block Connector

Figure D.9 shows a wiring diagram for using the AK-U0-RJ45-TB2P terminal block connectors.

Figure D.9 AK-U0-RJ45-TB2P Connector Wiring Diagram
Using RTU Master Mode

Accessing the Drives on RTU Master Network

Using one of the Allen-Bradley drive software tools enables you to monitor, configure, and control any of the drives on the RTU Master network. You can also monitor and configure the WIM.

Using Pocket DriveExplorer for Pocket PC

1. Re-establish wireless communication between the WIM and the computer. Launch Pocket DriveExplorer for Pocket PC. The ConnectionMgr screen (Figure D.10) appears. Select Connect > New to display the New Connection Wizard screen (Figure D.11).

2. Select the “Bluetooth” radio button and click Next -> to display the “Where is your destination?” screen (Figure D.12).
3. Select the “Remote” radio button and click **Next ->** to display the Bluetooth Browser screen (Figure D.13).

Figure D.13 Bluetooth Browser Screen

4. Select the drive to which the WIM is connected (for this example, PowerFlex 40 3P 460V 1.0HP), and click **OK** to display the Remote Configuration screen (Figure D.14). Enter a name (for this example, “Drive 1”) for the drive. Then set its node address (for this example, “1”) to match the node address set with drive parameter 104 - [Comm Node Addr].

Figure D.14 Remote Configuration Screen
5. Click **Next ->** to display the **Connection Summary screen** (Figure D.15) which shows information about this drive being connected to the network. Then click **Save and Connect Now** to display the “Location for saved connection” screen (Figure D.16).

![Figure D.15](image1.png)  
**Figure D.15** **Connection Summary** Screen

![Figure D.16](image2.png)  
**Figure D.16** **“Location for saved connection” Screen**

6. Use the default name shown or enter a desired name (for this example, Drive 1). Use the default directory shown or select a different path to which the connection is saved on the Pocket PC. Then click **OK**. The StatusMonitor screen for the drive appears.

7. Repeat Steps 1 through 6 for each remaining drive on the network.

8. After connections for all drives on the network have been created and saved, you can now select any drive to access its information. With any drive StatusMonitor screen (Figure D.17) displayed, select **Connect >** and then the desired drive file name (for this example, Drive 2.dfc) to display its StatusMonitor screen (Figure D.18). Then select **Tasks > Parameter (Linear)** to access its parameter list.

![Figure D.17](image3.png)  
**Figure D.17** **Drive Selection Screen**

![Figure D.18](image4.png)  
**Figure D.18** **Drive 2 StatusMonitor Screen**
Using DriveExplorer (Full Version Only)

1. Re-establish wireless communication between the WIM and the computer. Launch DriveExplorer. The application window (Figure D.19) will appear.

![DriveExplorer Full Application Window](image)

**Figure D.19 DriveExplorer Full Application Window**

2. Select **Explore > Connect > Serial to Network…** to display the Network Connection - Node Selection screen (Figure D.20).

![Network Connection - Node Selection Screen](image)

**Figure D.20 Network Connection - Node Selection Screen**

3. Select the “Multiple” radio button. Then enter the node address for the first network drive (for this example, “1”), and the node address for the last network drive (for this example, “3”) to view all drives simultaneously in the DriveExplorer online window. Click **Connect** to display the DriveExplorer network menu tree (Figure D.21).

**TIP:** If the network drive node address is valid, “Online” is shown next to the selected address. If a node address is not valid, “Offline” will appear.
4. Click on each node in the menu tree to create its database and identity. Then expand each node to display the connected drive and WIM representation (Figure D.22).

**TIP:** WIM representation appears for each drive in the menu tree even though there is only one WIM on the network. To access the WIM parameters, click any WIM shown in the menu tree.
Using DriveExecutive

1. Re-establish wireless communication between the WIM and the computer. Launch DriveExecutive. In the application window, select **Drive > Connect to Drive**… to display the Connect to Drive window. Then expand the menu tree in the left pane to display either the “Unrecognized Device” icons (which represent the drives) or the “DSI” icons. The window should look similar to Figure D.23.

![Figure D.23 Connect to Drive Window](image)

2. Select the drive to which you want to connect to (for this example, the node address 01 drive) and click **OK**. DriveExecutive will upload the drive information and display its online window (Figure D.24).

**TIP:** If the drive information does not exist on the computer or is different than existing information on the computer, DriveExecutive will automatically create a database file for the drive before displaying its online window.
3. Repeat Steps 1 and 2 for each remaining drive on the network. Figure D.25 shows online windows for each of the drives in this example RTU Master network.

Figure D.25 Drives 1 - 3 Online Linear List Windows
A  **Application Code**  
Code that runs in the WIM after the boot code calls it. It performs the normal operations of the system.

B  **BCC (Block Check Character)**  
An error detection scheme where the 2’s complement of the 8-bit sum (modulo-256 arithmetic sum) of all data bytes in a transmission block. It provides a means of checking the accuracy of each message transmission.

**Bluetooth Wireless Technology**  
*Bluetooth* wireless technology enables cable-free connection of devices that would normally be physically linked by wires, such as a drive connected to a computer.

**Boot Code**  
Code that runs when the WIM first receives power. It checks basic operations and then calls the application code.

C  **ControlFLASH**  
ControlFLASH is an Allen-Bradley software tool that lets users electronically update firmware on printed circuit boards. The tool takes advantage of the growing use of flash memory (electronic erasable chips) across industrial control products.

**CRC (Cyclic Redundancy Check)**  
An error detection scheme where all of the characters in a message are treated as a string of bits representing a binary number. This number is divided by a predetermined binary number (a polynomial) and the remainder is appended to the message as a CRC character. A similar operation occurs at the receiving end to prove transmission integrity.

D  **DF1 Protocol**  
A peer-to-peer link layer protocol that combines features of ANSI X3.28-1976 specification subcategories D1 (data transparency) and F1 (two-way simultaneous transmission with embedded responses).
DSI (Drive Serial Interface)
DSI is based on the Modbus RTU serial communication protocol and is used by various Allen-Bradley drives and power products, such as PowerFlex 4, PowerFlex 40, PowerFlex 40P, and PowerFlex 400 drives.

DSI Peripheral
A device that provides an interface between DSI and a network or user. Peripheral devices are also referred to as “adapters” or “modules.” The WIM and PowerFlex 4-Class HIMs (22-HIM-xxx) are examples of DSI peripherals.

DSI Product
A device that uses the DSI communications interface to communicate with one or more peripheral devices. For example, a motor drive such as a PowerFlex 4-Class drive is a DSI product. In this manual, a DSI product is also referred to as “drive” or “host.”

DriveExplorer Software
DriveExplorer software is a tool for monitoring and configuring Allen-Bradley products and adapters. It can be run on computers running various Microsoft Windows operating systems. DriveExplorer (version 3.xx or higher) can be used to configure the WIM and PowerFlex drives. Information about DriveExplorer and a free Lite version can be accessed at http://www.ab.com/drives/driveexplorer.

DriveTools SP Software
A software suite designed for running on various Microsoft Windows operating systems. This software suite provides a family of tools, including DriveExecutive, that you can use to program, monitor, control, troubleshoot, and maintain Allen-Bradley products. DriveTools SP (version 1.01 or higher) can be used with PowerFlex drives. Information about DriveTools SP can be accessed at http://www.ab.com/drives/drivetools.

EDS (Electronic Data Sheet) Files
EDS files are simple text files that are used by network configuration tools such as RSNetWorx for DeviceNet to describe products so that you can easily commission them on a network. EDS files describe a product device type, revision, and configurable parameters. EDS files for many Allen-Bradley products can be found at http://www.ab.com/networks/eds.
**F**  
**Flash Update**  
The process of updating firmware in a device. The WIM can be flash updated using the Allen-Bradley software tool ControlFLASH in combination with an Allen-Bradley drive-configuration software tool, such as Pocket DriveExplorer for Pocket PC, DriveExplorer or DriveExecutive.

**H**  
**HIM (Human Interface Module)**  
A device that can be used to configure and control a PowerFlex 4-Class drive. PowerFlex 4-Class HIMs (22-HIM-xxx) can also be used to configure connected peripherals such as the WIM.

**Hold Last**  
When communications are disrupted (for example, a cable is disconnected), the WIM and PowerFlex drive can respond by holding last. Hold last results in the drive receiving the last data received via the DF1 connection before the disruption. If the drive was running and using the Reference from the converter, it will continue to run at the same Reference.

**N**  
**NVS (Non-Volatile Storage)**  
NVS is the permanent memory of a device. Devices such as the WIM and drive store parameters and other information in NVS so that they are not lost when the device loses power. NVS is sometimes called “EEPROM.”

**P**  
**PCCC (Programmable Controller Communications Commands)**  
PCCC is the protocol used by some controllers to communicate with devices on a network. Some software products (for example, DriveExplorer and DriveExecutive) also use PCCC to communicate.

**Pocket DriveExplorer for Pocket PC Software**  
Pocket DriveExplorer for Pocket PC software is a Pocket PC tool for monitoring and configuring Allen-Bradley products and adapters. It can be run on a Pocket PC running Microsoft Windows Mobile 2003 (or higher) operating system. Pocket DriveExplorer for Pocket PC (version 1.x.x or higher) can be used to configure the WIM and PowerFlex drives. Information about Pocket DriveExplorer for Pocket PC can be accessed at [http://www.ab.com/drives/driveexplorer](http://www.ab.com/drives/driveexplorer).
**PowerFlex 4-Class (Component-Class) Drives**

The Allen-Bradley PowerFlex 4-Class family of AC drives includes the PowerFlex 4, PowerFlex 40, PowerFlex 40P, and PowerFlex 400. These drives can be used for applications ranging from 0.2 kW (0.25 HP) to 7.5 kW (10 HP).

**Status Indicator**

A status indicator is an LED that is used to report the status of a device. The WIM has one status indicator that emits blue, green, or red indications.

**WIM (Wireless Interface Module)**

The WIM provides a wireless communications interface between any Allen-Bradley DSI drive and a computer or Pocket PC with an RS-232 port. The WIM uses a full-duplex RS-232 DF1 protocol. The WIM may also be referred to as “22-WIM-N*,” “DSI peripheral,” or “module.”

**Zero Data**

When communications are disrupted (for example, a cable is disconnected), the converter and drive can respond with zero data. Zero data results in the drive receiving zero as values for Logic Command, Reference, and Datalink data. If the drive was running and using the Reference from the converter, it will stay running but at zero Reference.
A
accessing parameters, 3-1
Adapter Cfg parameter, B-1
Adapter Type parameter, B-1
application code, G-1
assigning name for WIM (optional)
using DriveExecutive, 3-23
using DriveExplorer, 3-14
using Pocket DriveExplorer for Pocket PC, 3-8
attentions, 1-4

B
BCC (Block Check Character), G-1
Bluetooth wireless technology, G-1
boot code, G-1

C
Clear DF1 Counts parameter, B-2
clearing DF1 data, 4-5
clearing events, 4-5
Comm Flt Action parameter, B-2
communications specifications, A-1
compatible products, 1-2
components, 1-1
configuration tools for parameters, 3-1
ControlFLASH, G-1
CRC (Cyclic Redundancy Check), G-1
diagnostic items, 4-3
dimensions, A-1
Drive Addr Act parameter, B-2
Drive Addr Cfg parameter, B-1
DriveExecutive
using to establish wireless connection, 3-16
web site, see DriveTools SP
DriveExplorer
definition, G-2
free Lite version, G-2
using to establish wireless connection, 3-10
web site, G-2
drives, see DSI products
DriveTools SP
definition, G-2
web site, G-2
DSI
compatible products, 1-2
definition, G-2
peripheral definition, G-2
product definition, G-2

E
EDS (Electronic Data Sheet) Files
definition, G-2
web site, G-2
EEPROM, see Non-Volatile Storage (NVS)
equipment
required, 1-3
supplied, 1-3
event queue
clearing events, 4-5
list of events, 4-4
viewing events, 4-4
F
fault action, 3-24
fault queue, see event queue
firmware
parameters in, 3-1
release, P-3
flash update, G-3
flash updating DSI peripherals wirelessly
using DriveExecutive, C-11
using DriveExplorer, C-6
using Pocket DriveExplorer for Pocket PC, C-1

H
HIM (Human Interface Module), G-3
hold last
definition, G-3
setting, 3-24

I
installing the WIM
NEMA 1, 2-1
NEMA 4, 2-2

L
LED, see status indicator

M
manual
conventions, P-3
related documentation, P-1
web site, P-1
mechanical specifications, A-1

N
naming the WIM (optional)
using DriveExecutive, 3-23
using DriveExplorer, 3-14
using Pocket DriveExplorer for Pocket PC, 3-8

Non-Volatile Storage (NVS), G-3

P
parameters
accessing, 3-1
configuration tools for, 3-1
convention, P-3
list of, B-1–B-2
numbers of, B-1
PCCC (Programmable Controller Communications Commands), G-3
Pocket DriveExplorer for Pocket PC
definition, G-3
using to establish wireless connection, 3-2
web site, G-3
power consumption, A-1
power cycle, 3-26
PowerFlex drives, G-4
products, see DSI products

Q
quick start, 1-5

R
radio
frequency, A-1
power, A-1
range, A-1
transceiver, A-1
regulatory compliance, A-2
related documentation, P-1
removing the WIM, 2-4
Reset Module parameter, B-2
resetting the WIM, 3-26
RSLinx, P-1
RTU Master mode, D-1

S
safety precautions, 1-4
Security Mode parameter, B-2
Security PIN parameter, B-2
specifications, A-1
status indicator
definition, G-4
locating, 1-6
troubleshooting with, 4-1
understanding, 4-1

T
technical support, P-2
tools, see equipment
troubleshooting, 4-1

U
update, see flash update
using RTU Master mode, D-1

V
viewing
DF1 data, 4-5
diagnostic items, 4-3

W
web site
DriveExecutive, G-2
DriveExplorer, G-2
DriveTools SP, G-2
Pocket DriveExplorer for Pocket PC, G-3
technical manuals/
documentation, P-1

WIM
assigning a name (optional)
using DriveExecutive, 3-23
using DriveExplorer, 3-14
using Pocket DriveExplorer for Pocket PC, 3-8
components, 1-1
collection tools for parameters, 3-1
diagnostic items, 4-3
event queue, 4-4
features, 1-2
illustration, 1-1
installing, 2-1, 2-2
parameters, B-1–B-2
removing, 2-4
resetting, 3-26
wireless flash updating DSI peripherals
using DriveExecutive, C-11
using DriveExplorer, C-6
using Pocket DriveExplorer for Pocket PC, C-1

Z
zero data
definition, G-4
setting, 3-24